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Preface, designated use

The UMB-Config-Tool has been created for configuring, commissioning, maintaining,
calibrating and checking Lufft UMB sensors, modules and systems.

It is not designed for reading out and storing data permanently. For the permanent data
evaluation Lufft offers the software SmartView3.

The UMB-Config-Tool is single seat software. It is not intended that multiple users use this
software from the same directory at the same time.

The UMB-Config-Tool is able to create logfiles. When these files are opened by other
programs during the operation of the UMB-Config-Tool, there might occur writing errors (i/o
Errors) when the UMB-Config-Tool tries to update them, and the file will not update correctly.
Details to special functions for sensors can be found in the operating instructions of the
sensor.

Installation UMB-Config-Tool

Start ‘Setup_UMB_Config_xxxxxxx.EXE’ and follow the instructions of the installation
programme.

The software is installed under ‘C:\Luff\UMB-Config’ as standard. In MS-Windows Vista and
MS-Windows 7 you must not install the software in the directories C:\Program Files or
C:\Program Files (x86) because these directories are specially protected system directories,
and the protection does not work well with the normal program function of this tool.

Start the application with ‘Start’ > ‘Programme’ - ‘Lufft UMB Config’ - ‘Config Tool'.

Installation paths:

Path Content
..\Luff\tUMB-Config\ Application and INI files
...\LUff\UMB-Config\Firmware Device firmware (mot files)
...\LuUfftUMB-Config\Hexload Bootloader programme
..\LufftUMB-Config\Konfig Stored device configurations

Copy the current device firmware into the firmware directory prior to installing firmware
updates.

The UMB-Config software can be uninstalled with ... \Luff\UMB-Config\UNWISE.EXE'.
System requirements

Windows 2000/ XP / Vista / 7

10 MB free hard disk capacity

A free serial interface (COM) for configuration, diagnosis and firmwareupdate
Alternative: TCP/IP connection to the measurement setup for configuration and diagnosis

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 3
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Communication settings / communication

The UMB Configtool works in principle with connections to the measurement setup with
connection settings 19200 baud, 8 data bits, 1 stop bit, no parity. A different baud rate is only
possible by editing the file ULSPS.INI.

From UMB Configtool version 1.5 in addition to the direct serial connection to the
measurement setup a connection using TCP / IP is supported. The TCP / IP communication
is enabled in the UMB Configtool by setting ‘Edit’ ->' Use TCP / IP '. The measurement setup
is connected to an RS-232/RS-485 to LAN / WLAN adapter (or similar device). The UMB
Configtool supports the connection to a host name or IPv4 address. Because TCP / IP
connections as opposed to direct RS232 connections are affected by latency, an additional
timeout has to be specified to wait for the responses of the devices in the UMB-setup. The
times given in the configuration dialog are ms. For direct LAN connections to IP addresses,
values of 100 (ms) are sufficient. For example, targets with name resolution and GPRS
connections require values up to 10000 (ms).

Note: Only the communication connection type ‘raw’ is currently supported (not Telnet
emulation).

Note: The set times are also considered for RS232 connections.

Eunfigure TCP/IP settings - |I:I|5|
Hostadrezs or hostname TCP-Port
[192188.013 |=000

Additional Timeout for slow connections to host [TCP/IP]

A 5
Q. | Cancel |

Creating a sensor list

Menu: Edit 2 Sensors:

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 4
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Station Sensors (=]
Sensor Selection
Tupe of Senzor [}
|vs20-UMB =l p
SavesExit |
Delete | Madify Configure | Cancel/E xit |
Update Channellist | Firmwareupdate Senzar |
Selected Sensars
|n] IT_l,lpe Address Channels Active Channels

1 YW320-UMB 0x3001=12239 40 1}

Click Sensor to edit/remove Sensor Double Click Senzor to edit active channels

Autoscan | Werify | Save to Disk | Load from Disk. |

Status 08.08.2011 Version 1.7

Choose ,Type of Sensor’; enter an ID and add it with ,Add’ to the list. With ,Delete’ sensors
can be deleted, with ,Modify’ a sensor in the list can be modified. The sensor shown in

,Sensor Selection’ will be deleted or modified.

,Configure’ starts the configuration of the sensors in the list. ,Firmwareupdate Sensor’ starts
the module for updating the firmware of the selected sensor. ,Update Channellist’ reads the
channel list from the connected UMB-module / sensor and inserts new channels into the

existing channel list for this device.

Running ,Autoscan’ queries the network for existing UMB devices. ,Verify’ checks, if the

devices in the list are responding to communication from the master.

With ,Save to Disk’ the sensor list (including selected channels) can be stored for later reuse

(,Load to Disk’).

LR
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Configuring sensors

Status 08.08.2011 Version 1.7

Select a sensor from the list by clicking it, then click ,Configure’. You will get the following

dialogue:

Sensor Configuration

Load profile from gensor

Load prafile from disk.

Store profile on sensar

Store profile on disk:

Load adj. data fram disk

Claze

Select senzor to configure

I 0x3001=12283 v l

=1o]

The check box "select sensor to configure" allows to switch to another sensor of the

measurement setup.

Load the configuration of the sensor with ,Load profile from sensor’. Adjust the values in the

mask to suit your needs.

Sensor Configuration

Main | Info  VS20UMB |

General properties
D s

Ivisibility-sensor WS20-UME

Description

Communication properties
Linezpeed
Frotocol

Timeout protocal change

I 15200 < l
I binary - l

=10l

Dutput properties

Output made

|4..2Dm 'l
|2 Ev
IU..2UUDm 'l

Failure current [ma)]

Scaling

Meassurement Setup
Average far wisibility [min]
Offzet for vizibility

Border contrast

Average for temperature [min]

Offzet for Temperature

NN ]

Calibration values

DAL offset 62.85248 Calibration value
DAL gain 16311475 Calibration offzet

5016.69371
0.00042

Calibration status

Em—

‘Lufft
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After the values have been set, store them on the device with ,Store profile on sensor’.

=l x|

Info | wS20UME |

Select sensor to configure

Load profile from senzor | I 0x3001=12289 Vl

Load profile from disk |

Store profile on sensor |

Store profile on disk. |

Load ad),. data from disk |

Cloze |

With ,Store profile on disk’ a sensor configuration might be stored on a hard drive. Stored
configurations of sensors might be loaded with ,Load profile from disk’.

CopC
‘Lufft -
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Assigning Device ID’s

Each device in a UMB network requires a unique address.

Status 08.08.2011 Version 1.7

Addressing takes place via a 16 bit address. This is divided into a sensor class ID and a

device ID.

To avoid address duplication, the device ID’s are assigned in ascending order per sensor

class (i.e. sensor type):

Station Sensors

Sensor Selection

Tupe of Sensar o]
| ANACON-UMB =l of

-loj x|

Save/Exit |
Cancel/Exit |

Delete | fodify Configure |
Update Channellist | Firmwareupdate Senzor |
Selected Sensors
D | Tupe Addreas Channels Active Channel: I

AMACON-UMB | 0:5001=24577 135
AMACOM-UMB | 026002-=24573 135
AMNACON-UMB | 0:5003=24573 135
AMACOM-UMB | 0:6004=24580 135

1 IRSZ1CON-UME | 0x1001=4037 26
2 IRS21COM-UME | 0x1002=4098 26
3 IRSZ1CON-UMEB | 0x1003=4033 26
1 R25-UME 0x2001=81493 15
2 R25-UmE 0x2002=8194 15
1 WS20-UME 0«3001=12289 40
2 WS20-UMB 0x3002=12230 40
1
2
3
4

Click Senzor to edit/remove 5ensor

Autoscan | Werify | Save to Disk |

Drouble Click Sensor ko edit active channels

Load from Disk |

0

oo oo oo oo oo

ATTENTION: When configuring new equipment please note that new devices always have
the ID 1! If there are several sensors of the same type in a network it makes sense to
configure the sensors individually with their corresponding ID’s before commissioning the

network.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany
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Configuring ANACON-UMB

As the ANACON-UMB is a universal measurement transmitter which can be operated with
various analogue sensors, this module must always be configured to the connected sensor
before commissioning.

To do this, connect the module to the power supply (with no additional participants on the
bus) and connect to the PC via an RS232 cable (1:1). Load the current configuration via
‘Load profile from Sensor’ as in the section ‘Configure Sensor’:

Select the connected sensor type in ‘Measurement Setup’ under ‘Channel 1’ and ‘Channel 2’;

Sensor Configuration ;lglﬂ
Main | Irfa Anacon-LMB |
General properties Communication properties
D | Linespeed RS232 120 =]
Description lm Pratocal I binary j'
Timeout protocal change 10 =

Meazsurement Setup

General Parameters  Channel 1 |Ehannel2|

Senzor bype Meazsurement categary Unit
j Itemperature |°C
= M ax value Offzet it Unit from Channel

j700 {0.000 | =
combi wind [3368.01] Overange [%] Sensor powerup time [ms]
combi wind 4., 20mé extern m m
combi wind 4. 20m intern x =z
air preszure [3355.03

Mumber of samples for average
|5 j |1 2 j Average over 60 3

Channel description
Ichannel 1

If necessary, set the ID, measurement interval and number of measurements for the min-,
max- and average values:

M eazzurement intervall [g] Mumber of samples for average

j |12 j Average aver B0 s

Then save the amended configuration in the module with ‘Store profile on sensor’ under
‘Main’.

ATTENTION!! In the case of the temperature/humidity sensor (TFF 8160.TFF), the
values for C12 and C76, which are marked on the sensor head, must be recorded
under ‘General Parameters’!!!

General Parameters IEhanneH | Channel 2|
Altibude 350 4
TFF C12 = TFF C76 |1 950 2

LR
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Configuration of sensors operating in different protocols (e.g. MODBUS, SDI12)
If sensors are permanently set to protocols other than UMB (Binary or ASCII) they must be
changed first to the UMB protocol if you want to change the configuration with the UMB
Configtool.
The procedure for doing this is as follows:

1. Separate measurement setup from the supply voltage

2. Inthe UMB Configtool select 'Options' -> ‘Switch all sensors temporarily to UMB

protocol'

3. Connect the Measurement setup again to the supply voltage.

4. After about 5 seconds (or longer) click ,Exit' in the UMB Configtool
The sensors can now be configured for the time in minutes set under, timeout for protocol
change 'in the sensor settings by UMB Configtool. UMB telegrams e.g. Measurement
acquisition, configuration read / write reset the timeout to the time set. After a reset, the
sensor is running again in the configured protoco.
Note: After a ‘Store profile on Sensor’ the sensor is reset automatically by the UMB-
Configtool and then runs again in the configured protocol.

Query measurement values

The channel list of a sensor is opened by double clicking a sensor in the sensor list.

I=
Chhdr. |Measurement |L|nit |F|ange |Active | 1 Click on Channe! to toggle active
100 Act, temperature C -200.00 .. 450,00 active
120 Min. temperature °C -200.00 .. 450.00 ihachve
140 bax. temperatune T -200.00 ., 450,00 inactive
160 Ayg, temperature °C -200.00 .. 450,00 inactive
105 Act. temperature °F 3280084200  faciwe
125 Min, temperature F 32800, 84200 inactive
145 kax. temperature °F -328.00 .. 84200 inactive
165 Ayvg. temperature F -328.00 . 842.00 Inactive
110 Act. dewpoint °C -200.00 .. 450,00 inactive
130 kdin. dewspoint °C -200.00 .. 450,00 inachive
150 M. dewpaint T -200.00. 45000 |inactive Ok |
170 Avg, dewpoint °C -200.00 .. 450,00 inachive LI

Here you are able to select the channels for query.

Note: If a channel mentioned in the operating instructions of a sensor is not shown in the
sensor list, the channel list of the UMB-Config-Tool for this sensor needs to be updated. It is
advised, that you update the Firmware of the sensor before updating the channel list (see
chapter Firmware Updates).

The measurement is started in menu ,File’ = ,Start measurement’.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 10
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l:onfig—Software—UMB - COML1 - 19200 =101 x|
File Edit Cptions Help

ANACON-UME 101 temperature ['C] Act | AMACON-UME 101 temperature [°F] Act

AMACON-UME D1 relative humidity [%] |ANACDN-UMB 101 absolut hurnidite
Act [g/nF] Aot

21.27 70.29 3640 770
21.27 70.29 3645 7.7
21.27 70.29 3649 772
.27 70.29 3656 773
21.28 0.3 36.56 774
.26 70.27 3659 773
21.28 70.20 3655 773
21.27 70.28 3653 774
.27 70.29 36.45 771
21.27 70.29 36.50 772

To change the sampling rate of the software click ,Edit’ > ,Sampling Rate’. A sample rate of
1s does not correspond to the UMB-protocol. In the case of missing answers of the sensor it
can lead to erroneous presentation of the received values.

Attention: The selected channels only affect the data query in the UMB-Config-Tool. They
do not influence the query of channels in any other software.

Updating the channel list for a sensor

Add the desired sensor to the measurement setup and make it to the selected sensor (by
clicking the list entry).
o x|

Sensor Selaction
Type of Sensar |]
[pacansuMe =l
Save/Exit
Add | Delete | b odify Configure | Cancel/Exit |
Update Channellist | Firmwareupdate Senzor |
Selected Sensors

ID IT_l,lpe IAddress Channelz Active Channels I
1 DACONE-UME  O:FO0T=E1441 |0 Hil ;

Click Sersor to edit/remove Sensor Double Click Sensor to edit active channels

Autascan | Werify | Save to Disk | Load fram Disk. |

Then choose “Update Channellist”. The UMB-Config-Tool now reads the channels from the
desired sensor and sorts the new ones into the channellist. During this operation no channels
are deleted, but descriptions and other information of the old channels are replaced by the
newly read ones. Also the Type of Sensor might be changed during this operation. This
process also works for up to now unused sensortypes. However, such sensors cannot (jet)
be configured with the UMB-Config-Tool but querying measurement values works.

CORS
Y %
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Firmware Update

Before implementing any update, please check with Lufft concerning the current firmware
status of the UMB products.

Check current firmware status
The current status of the firmware should be checked before updating the firmware. To do

so, read the configuration under ‘SensorConfig’. The current version of the software is shown
under ‘Rev. software’ on the ‘Info’ page.

=i xi

Main  Infa | R2s-Ume |

Mumber |1

Tested 706

Project number |DDD?

Few. bom [

Rev. schematic |8

Rev. hardware JB\
@. software |4D \)

Rev. oot —— .

Rev. product |D

Clazs-id [

Mame |F! 25-UMEB

40 corresponds to Version V4.0

Lufft
Gl u G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 12
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Programme a Sensor Update

Before updating, save the current device firmware (mot file) in the installation directory under
‘Firmware’ (e.g. C:\Programme\Luff\UMB-Config\Firmware).

ATTENTION: When updating ANACON-UMB or IRS21CON-UMB, the RS232 connection
must be plugged directly into the module to be updated. Anacon-UMB and IRS21CON-UMB
with production date from February 2009 on can also be updated over the bus. ANACON-
UMB without frontside RS232 can only be updated over the bus. This requires at least one
ISOCON-UMB in the measurement setup.

ISOCON-UMB have to be updated manually. The corresponding instructions can be found
the section "Updating manually with HexLoad"

Open the sensor list under ‘Edit’ > ‘Sensors’; if necessary, regenerate the list with ‘Autoscan’
or load a stored list with ‘Load from Disk’. With ‘Verify’, check whether the sensors available
in the sensor list are also reachable on the network.

o]
Sensor Selection
Type of Sensor o]
|vs20UMB = p
Save/Exit |
add | Deete | Modiy Configure | ConcelEsit |
Update Channellist | Firrmwareupdate Senzor |
Selected Sensars
[} | Tvpe Address Channels Active Channels I
! VSOUME 0:3001=12289 |40 a
1 IRS21COM-UMB | 0x1001=4097 26 a
1 AMACON-UMB  0x6001=24577 135 1]
2 AMACOM-UMB | O46002=24578 135 a
1 R25-UME 0x2001=81493 15 1]
Click. Senzor to edit/remave Sensor Drouble Click Sensar to edit active channels
Autoscan | Werify | Save to Disk | Load from Disk |

Select the appropriate sensor from the sensor list; the selected sensor is displayed in the
‘Selected Sensors’ section (VS20-UMB in the example).

The update process is started with ‘Firmwareupdate Sensor’. The following window opens
when this function of the Config-Tool is used for the first time:

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 13
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Select path to Hexload-Program 21xl
Suchen in: I@UMB-Eonfig j L] &5 EE-

| Firmware

Dateinarme: I j Offnen I
Dateityp: IHeonad proqramn j Abbrechen |

g

Under ‘Hexload’, select the ‘HexLoad.exe’ file.

After this (and on all future updates) a window opens in which you select the relevant mot file
for the update:

Firmware to update current active sensor ﬂil
Suchen in: IE} Firmware j L EF '

;7‘*’ 0007_RRS_Release W42 mot
;7‘*’ anacon_telease_\'11.mot
'fl'""isocon_release_\n'IZ Lok

release_\V16.mat

[ ateiname:; Ivs2ﬂ_lelea$e_\f18.mot j Qiffrien I
j Abbrachen |
A

D ateityp: I Firmnware: file

Ufft G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 14
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The device is then programmed:

Status 08.08.2011 Version 1.7

JRI=TEq
File Edit Wiew Target Options MWindow Help
.ﬂ: Project ;Iglﬁl E-: Target ;Iglil
Hexfile: ¥520_RELEASE V16.MOT Range E8B000 - FDFEF
COM Port: COM1 CRC: —
Baudrate: 19200 Application: BTL_V¥S20_¥3 Jun 6 2006 16:04:
CPU: M16C28 64pin
BTL Yersion BTL V3.00

% Current data - [D:\PROGRAMME,LUFFT',UMB-CONFIG FIRMWARE, ¥520_RELEA B[] B4
Address: [0+£8000 [ =2|

fiddress | B |1 [2 [3 (4[5 [67[8[9 | A[B[C|[D]E]F[ASCII lﬁ!

ESBBA FC EF 7@ 9% 18 @5 @ FA A@ 96 C9 @4 C4 F@ 70 C% __p... .. ..... -

E8Bi@ C 04 28 Flemeemmemmomm s _'x'.(...2 .........

E8P208 |84 7@ n8 @3 Heellel il | M T

ESE3@ |1C F3 4C 46 ¢ LF .. xh

E8B46 9F B2 48 F4 H...u 4.N

E8B5A 68 6E 2A B2 n*.t “a=

E8B6H 3C F6 CA 5F 9y f e mmmsEmsEmEan

ESB87@ 24 @1 &8 F? = h..Ti.....e.B

rgwge |8 98 50 61 | Pov... oo B

ESa?8 5C F? 24 @8 -

ESPAD__|F? @@ 88 FA Cancel | Cdevennnnn P

EgBBA Fa 82 M1 M@ 0 —-] e eeaamana

EgachA ?C FC 94 &F 0 D.

EgBaDa 9D BA A FD CA BE 2% 80 BC FE CA FD 8C 88 78 FE .......ccccun- .

EGPER |(AE 62 85 @@ D4 FE 48 37 7E B0 38 FF 26 76 77 88 .b....E7V.8.&vw.

EGAFA |2C FF 24 1A 71 B8 0@ 0@ EO 1D 6B 88 64 8@ 28 7C ..5.q.....k.d.d1

EGiPA |65 9@ C8 @@ CA 2F 6@ 8@ 2C A1 A8 33 5B 8@ 90 A1 e.... " ....3[...

Eg118 A4 82 56 BA F4 A1 A8 17 52 BB 58 B2 A6 ED 4D 8@ .. U. ... _R.H_.._M.

Eg128 BC B2 4C 8@ 4n 8@ 28 B3 64 4B 46 B8 &4 B3 B6 CA .. L.J. _dKF.._..

FR1IA |42 AA FA AT AA 70 3F AA 4" R4 7R GL 3¢ AR RA R4 R »? T wvll¢ ﬂ

1o x|

CRC of loaded file; D9E4 ﬂ
Clear target started
Clear target succeed
Frogramming target started
[ H
|Ready 5

After successful programming the Config-Tool reports as follows:

\ij) Firmware update succeeded

X

The device then operates with the new firmware.

Possible sources of error

- If afirmware is selected which does not correspond to the sensor, the error message
‘Invalid Firmware-Filename for this module’ is displayed.

- When updating older ANACON-UMB or older IRS21CON-UMB, the RS232 connection
must be plugged directly into the module to be updated.

- An ISOCON-UMB cannot be updated using this procedure (see page 20, Manual Update

with HexLoad).

‘Lufft
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Calibration of a VS20-UMB visibility sensor

Start by creating a sensor list, containing the VS20-UMB to adjust. Example:

Station Sensors ]|
Sensor Selection

Tupe of Sensor

D
[Fzs-uME =]

Save/Exit |
Add | Delete | fodify Configure | Cancel/Exit |

Update Channellist | Firmwareupdate Sensor |
Selected Sensars
D | Tupe Address Channels Active Channelz I
1 R25-UMB 0x2001=8193 15 0
1 AMACON-UME | 0x6001=24577 135 0
1 Y520-UMB 0x3001=12239 40 0
Click Senzor to edit/remove 5ensor Drouble Click Sensor ko edit active channels
Autoscan | Werify | Save to Disk | Load from Disk |

Then chose ,Save/Exit’, ,Calibration > ,VS20-UMB'.
Run the calibration according to the description in the text field and like described in the
manual from the calibration kit. See picture below.

ECOhfig—Software-UMB - COM1 - 19200 =10l x|
Eile. Edit  Options  Help
r—Calibration Steps
| 0x3001=12289 =l
(Ol |
Calibration process VS20-UMB Start |
2
Step 1
C3 Required items: Stop |
1x Calibration kit visibility (3366.UKALT)
4
The calibration procedure will take about 10 minutes.
o ‘When the calibration process is interrupted, the ¥S20
will not measure until reset or power off.
8 Press "Start" when you have all the equipment ready
and you want to proceed
L Press "Stop" to cancel
8
(@]
Scattering coefficient |Enlel scattering coefficient here

Ufft G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 16
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Resetting the rain quantities of WSx-UMB

With the menu point 'Extras -> reset WSx-UMB rain sums' the absolute values of the rain
guantities in all connected WSx-UMB are set back to 0. It is not necessary to establish a
measurement setup with the WSx-UMB. It is however recommended to check if the
command has been carried out successfully by reading out the respective values on the
corresponding WSx-UMB.

Resetting the service level of NIRS31-UMB

After carrying out maintenance and replacing the reflector unit, the sensor must be informed
about this procedure using the UMB-Config-Tool.
In the menu under ‘Options’, select the entry ‘NIRS31-UMB Service’:

@ Config-Software-UB

File Edit Help

IR521-LIME 3

R5232 special functions
W320-UMB Callibration
M Sx-UMB reset rain
MIRS31-UME Service

Confirm the performance of maintenance with ‘OK’.
MIRS3L-UMB Service (=3

The following work s were caried out according to the manual:

[v reflector unit has been replaced

Cancel

Important note: Only use this function if maintenance was actually carried out and the
reflector unit was actually replaced.

Miscellaneous

,Edit’ a ,Password entry’ allows the user to change in a different user group with advanced
possibilities.

Parameters only adjustable by modifying the file ULSPS.INI:

[Settings]

LogToFile=1

Writes the measurement values into a log file, file name see ,LogFileName’. The column
headers are formatted GrouplD:ID:Channel (see table of measurement values).

LogFileName=Values.Txt
Basic file name for the log file. Will be expanded by the current date. The software creates a
new file for every new date.

CreateDayFiles=1
The registered values are stored in daily files. If the value is 0, they are all stored in one
single file.

G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 17
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MaxRetriesForProtocolWhenFailure=2
Number of retries per command, before a failure is reported.

AdditionalTimeoutinMSForSlowConnectionsToHost=0

Time in ms, which is waited additionally to the period of reply specified in the UMB protocol,
before for this instruction Timeout is produced. The time specified in the protocol applies to
direct 1:1 communication. If the query is made e.g. by GPRS consider using 10000 (ms,
corresponds with 10s) here. Note: With 2 repetitions for each instruction (see
MaxRetriesForProtocolWhenFailure) it takes 3x10s = 30s, before this instruction is rated as
,Failed. Absolutely consider if an ,Autoscan’ is to be accomplished, and/or a measured value
guery is run with a short interval. This setting will be adjustable in the TCP/IP configuration
dialogue.

AutoScanDeltaForFail=3

With ,Autoscan’ for each possible group by address 1 beginning ,a ,Verify’ command is sent.
If the device does not respond the next AutoScanDeltaForFail-1 addresses in ascending
order are queried with ,Verify'. The queried groups are 1 to 14 (group 0 is used for equipment
spreading broadcasts, group 15 are masters, here the software itself.

Example: Messurement setup with 1 device of group 2 Id 1 and 1 device of group 3 Id 2.
AutoScanDeltaForFail is set to 3.
List of queries (addresses, in Groupid:ld notation):

1:1 — Failed
1:2 — Failed
1:3 — Failed
2:1-0K
2:2 — Failed
2:3 — Failed
2:4 — Failed
3:1 - Failed
3:2-0K
3:3 — Failed
3:4 — Failed
3:5 — Failed
4:1 — Failed
4:2 — Failed
4:3 — Failed
5:1 — Failed
5:2 — Failed
5:3 — Failed
6:1 — Failed
6:2 — Failed
6:3 — Failed
7:1 — Failed
7:2 — Failed
7:3 — Failed
8:1 — Failed
8:2 — Failed
8:3 — Failed
9:1 — Failed
9:2 — Failed
9:3 — Failed
10:1 — Failed
10:2 — Failed

10:3 — Failed
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11:1 — Failed
11:2 — Failed
11:3 — Failed
12:1 — Failed
12:2 — Failed
12:3 — Failed
13:1 — Failed
13:2 — Failed
13:3 — Failed
14:1 — Failed
14:2 — Failed
14:3 — Failed

Thus 45 telegrams, in order to find the 2 devices (with this ID). Since every ,Failed’ is
repeated 2 times (default setting), that is altogether 131 queries. If now
AdditionalTimeoutinMSForSlowConnectionsToHost is set to 10s ,Autoscan’ takes about 25
minutes - so choose the parameters carefully if the ,Autoscan’ function is to be used.
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Manual Update with HexLoad

The following procedure must be applied if a sensor update using the Config-Tool was
interrupted or in the case of an ISOCON-UMB.

Update ISOCON-UMB

Disconnect the power supply and the connected sensor from the ISOCON-UMB module
Connect the RS232 interface of the ISOCON-UMB module to the PC

Start HexLoad (...\Programme\Luff\UMB-Config\Hexload\HexLoad.exe)

Load the current mot file with ‘File’ > ‘Open’. This must (!!!) have the file designation
‘isocon_release_Vxx.mot’, where ‘xx’ specifies the version number.

Switch on the power supply of the ISOCON-UMB module.

‘BTL_ISOCON_VXx...." must now be displayed in HexLoad in the ‘Target’ window next to
‘Application’.

. Hexl oad ¥3.00j - O] =|
File Edit Wiew Target Options ‘Window Help
;IEIEI .ﬂ Target ;IEIEI

Hexfile: 12.mut Range: E8000 - FDFEF
e

COM Port: CRC:

Baudrate: 19200 Application: BTL_ISOCOM_P1 Jun 6 2006 15:5

CPU: MG i pin
BTL Yersion BTL ¥3.00

PN PE

o g

,ﬂ Projeck

% Current data - [N:4PROJEKTE} D509 1SDC i ] |
Adess: [0:E8000 [ul 2| wt)

[Address T8 12 3 4]5T6 7 619 ATBICIDIEFIASCII <]
""" FRAGA 2T 2T 2T 2T 2?0 49 £3 4AF 4% 4AF 4F 20 2T 20 2N 2T ——— T2ACNAN ———

7. Start the programming with F9.
8. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
9. The module is now ready for operation with the new firmware.

Manual Update of IRS21CON-UMB
If it is necessary to update an ISR21CON-UMB module manually, proceed as in the case of

‘Update ISOCON-UMB’, where the name of the mot file must correspond to
‘IRS21con_Vx_x.mot’.

G
Lufft -
5 G. Lufft Mess- und Regeltechnik GmbH, Fellbach, Germany 20




Operating Instructions UMB-Config-Tool

Status 08.08.2011 Version 1.7

Manual Update of VS20-UMB, R2S-UMB and other UMB-Sensors

1. Disconnect the power supply of the sensor from the ISOCON-UMB
2. Switch on the power supply of the ISOCON-UMB module
3. Connect the RS232 interface of the ISOCON-UMB module to the PC
4. Start HexLoad (...\Programme\Lufft\tUMB-Config\Hexload\HexLoad.exe)
5. Load the current mot file with ‘File’ = ‘Open’. The file must (!!!) have the following
designation, where ‘xx’ specifies the version number.
e VS20-UMB: ‘vs20_release_Vxx.mot’
e R2S-UMB: ‘R2S_Release_Vxx.mot’
e WSx-UMB: 'WSx_Release_Vxx.mot’
e |RS31-UMB: IRS31_Vxxx.mot’
e ARS31-UMB: ‘ARS31_Vxx.mot’
e VENTUS-UMB: ‘Ventus_Vxx.mot’
e V200A-UMB "Ventus_Vxx.mot’ (!)
¢ NIRS-UMB: ‘NIRS_Release_Vxx.mot’
6. Connect the power supply of the sensor to the ISOCON-UMB module.
7. The following test must now be displayed in HexLoad in the ‘Target’ window next to
‘Application’:
e VS20-UMB: ,BTL_VS20 V...
Hexfile:  _vs20_release_V¥.mot Range: E8000 - FOFEF
COM Port: 5 CRC:
Baudrate: 19200 Applicatlu” 6 2006 16:04:
CcPU:
BTL Version BTL V3.00
e R2S-UMB: ,BTL_R2S V.....
=101 x| =10l x|
Hexdile: .mot Range: E8000 - FDFEF

COM Port:
Baudrate:

19200

CRC:
Applicatiun 3 2006 09:44:5
CPU:

BTL Version BTL V3. I]I]

8. Start the programming with F9.

9. If programming is successful the message ‘Job succeed’ is displayed; then exit HexLoad.
10. The module is now ready for operation with the new firmware.
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